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Fully licensed & certified file–based software plug-in encoder for:
• AudioSuite plug–in for Pro Tools 7.4 to 10.3.7
• AudioSuite plug–in for Media Composer family 6 & 7
• Final Cut Pro Export Plug-in for Final Cut 6 & 7
• VST plug–in for qualified 32 bit VST 2.4 surround hosts
• Intel Mac OS X 10.4 to 10.8
• Windows XP, Vista & Win 7
An iLok USB Smart Key and iLok account are required.
Note: Only the AudioSuite Encoder is version 2.2, the remaining elements of this
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Introduction

1 Introduction
Dolby E is used to transmit audio-for-video from a network center to affiliate
stations, where it is decoded into analog or PCM, or re-encoded into Dolby
Digital for rebroadcast to the consumer.
The Dolby E data takes the space of a stereo pair of digital audio, at 48
kHz. Dolby E contains up to 8 channels which can be divided in different
ways to create up to 22 unique channel configurations, called Program
configurations. Each Program configuration is made of one or more programs, or groups of channels. A program can be a single mono channel, a
stereo channel, or multichannel surround sound up to 5.1 channels. A Program configuration can be combinations of Programs such a 5.1 plus stereo. See Appendix A for a complete list of Program configurations.
This plug-in is available as a file-based-only plug-in. The plug-in reads up
to 8 tracks of audio from the host application, and encodes them into a single Dolby E file. The user interface allows for easy selection of all available
encoding parameters, including AC3 metadata.
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2 A Dolby E Primer - Getting Started
2.1 Dolby E Workflow Check List
1. When working with Dolby E content, be conservative about monitor
gain. Otherwise, accidentally routing Dolby E material to your monitors can
be a surprising and sometimes painful experience.
2. Make sure your Digital Audio Workstation session is set to 24 bit.
3. Make sure that no processing whatsoever is being applied to the Dolby
E stream, including redithering, gain or sample rate changes.
4. Dolby E is intimately tied to video frame boundaries, so incorrect offset
will cause your audio to be out of sync with the picture: confirm your offset
setting.
5. When laying back, don't forget to set your DVR's audio edit mode to
CUT, and that it is in "Data" or "Burst" mode.
6. Some VTRs allow you to disable variable input gain, often by pushing or
pulling the level control knobs so they are in a locked or "0 dB" position.
The VTR user guide for your particular model will have information about
this feature.
7. After layback, play back and decode the Dolby E content from tape to
make sure that it decoded properly & your metadata is correct.
8. Make sure your metadata matches the program, your intended settings
and production expectations.

2.2 Dolby E Offset
Offset is often a puzzling setting, but it doesn't have to be. If you are part of
an all-software or file-based workflow, then you can leave the SurCode for
Dolby E Encoder offset at zero. Only when hardware is involved as part of
your workflow do you need to consider whether a non-zero offset is
required.
Recall that hardware encoders and decoders each have 1 frame of latency.
Each piece of hardware retards by one frame…To compensate for hardware latency introduced elsewhere in your workflow, use positive Frame
Offset values in the SurCode for Dolby E Encoder. A positive Frame Offset
SurCode for Dolby E Encoder
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setting of "+1 frame" will compensate for one pass through legacy hardware.
What if your workflow requires that you encode as though you were using
hardware instead of a software plug-in? In that case you would want to
emulate or act like a hardware encoder. To emulate a single pass through
legacy hardware in SurCode for Dolby E, use a negative Frame Offset setting of "-1 frame." Negative values retard or delay, which is to the right
on your timeline. Positive to advance, negative to retard.
The SurCode for Dolby E Decoder does not have offset compensation but,
note that, when decoding from a file, no offset is introduced by the decoder
internally. Again, assuming an all file-based workflow, the offset is zero. If
you decode from the timeline, then an internal offset results because a
frame's worth of data must pass through the decoder before it can deliver
decoded PCM from the Dolby E data. When in doubt about a complete
workflow, always send a test file or layback to your downstream production
partner to make sure that everyone is in agreement.

2.3 Guard Band
A guard band is an unused or unoccupied portion of a communication carrier used to prevent spectral or temporal overlap which, in turn, can cause
interference with the information being transmitted. Guard band is also a
term often used as part of a specification or requirement when submitting
material in Dolby E format.
One common spec stipulates that the Dolby E guard band "position" in
time, as it relates to video, must be on line 33, for a 1920 x 1080, 23.98
progressive video master. What does that mean to you? For engineers, the
basic question is, "How can you make sure that my Dolby E file has its
guard band positioned correctly?"
At Minnetonka Audio, we follow the specifications provided by Dolby Laboratories. That allows our products, like SurCode for Dolby E, to be certified
and completely reliable in the field. If you're using a modern encoder that
conforms to the current Dolby spec, like SurCode for Dolby E, simply set
the frame rate and offset according to your workflow, and your material will
be universally compatible.
The whole purpose of a guard band is to insure that there's enough tolerance so encoders and decoders will always sync, lock and recover data in
any real world production situation. Referring to the requirement mentioned
above, it is based on a Dolby specification published in 2008 that has since

SurCode for Dolby E Encoder

page 3

A Dolby E Primer - Getting Started
been superseded. The current "Dolby E Reference Line Position" table can
be found at:
http://www.dolby.com/uploadedFiles/Assets/US/Doc/Professional/DolbyELinePositionTable.pdf
For any setting, SurCode for Dolby E will produce material with the line
position conforming to the middle of the Dolby spec, centered on 80 microseconds, and be exactly as per the spec's "Ideal Position, ±80 µS" center
column.
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3 Main Screen
Figure 3-1 shows the SurCode for Dolby E Encoder plug-in.

Figure 3-1

3.1 Program Configuration
A Dolby E “Program” is a group of tracks that carry one item of audio content. The Program can have as few as one channel or as many as 6 channels (in a 5.1 surround format). Combinations of Programs are grouped
together to form “Program Configurations”. Each program configuration
can have as few as one program, and as many as 8 programs.
You must tell the encoder what Program Configuration you want to use for
encoding. The default on start-up is “5.1 + 2”.
SurCode for Dolby E Encoder
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The Program Configuration is selected from a pull-down menu in the
upper-left corner of the plug-in (see Figure 3-2).

Figure 3-2
A check mark indicates the currently selected Program Configuration.
Below the Bit Depth selector is a listing of all programs in the selected Program Configuration (see Figure 3-3). Each Program lists the channels that
are present in that Program. You can select the Dialog Level for each channel from a pull-down menu, and you can enter a Description of the Program. The Dialog Level and Program Description information is duplicated
on the Program Tabs.

Figure 3-3
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3.2 Bit Depth
Directly below the Program Configuration selector is the Bit Depth selector
(see Figure 3-4).

Figure 3-4
All Program Configurations can be encoded in 16 or 20 bits. 16-bit is not
available for Program Configurations which have more than 6 channels.

3.3 Output File Name
You must select a file name and path for the new Dolby E encoded file. To
name an output file, click on the Browse button under the File Name display (see Figure 3-5), browse to the location where you want to write the
new encoded file, and type in a file name. The new file name will now
appear above the Browse button
.

Figure 3-5

3.4 Import Metadata
A typical Dolby E encoded file will contain both Dolby E metadata (such as
Program Configuration and Bit Depth) and AC3 metadata (such as Dialog
Level and Preferred Downmix Mode). All of this metadata can be saved
into the header of a .wav file (called the “dbmd chunk”), and retrieved for
later use. The metadata can also be stored in a .xml file. The saving of
SurCode for Dolby E Encoder
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metadata into a .wav or .xml file is done during decoding, so that the metadata associated with that audio will not be lost. SurCode for Dolby E
Decoder, for example, can save the metadata in these ways.
SurCode for Dolby E Encoder makes it easy to grab metadata stored in a
.wav or .xml file and use it in your current project. Just click on the Import
Metadata button under the File Name. It will bring up a browse window
from which you can choose a file with a “.wav” or “.xml” extension. The
imported metadata will immediately appear in SurCode, both on the Main
tab and on the Program tabs.

3.5 Frame Offset
SurCode for Dolby E Encoder allows for a time shift of the audio relative to
the video. This can be very useful with projects that involve encoding or
decoding during tape transfers because these operations often contribute
one frame of shift between the audio and video. Please refer to
Section 2.2 on page 2 for more information.
SurCode has a pull-down menu to select no offset, or one or two frames of
offset, either advanced or delayed (see Figure 3-6). The plus (i.e. positive
number) means the audio is being advanced relative to the video. So, a 1
Frame advance would add 1 frame to the audio and push it to the right in
the timeline, etc.
.

Figure 3-6
The frame offset is recorded into the BWF header of the .wav file in the
Coding History “T” field, like this: “T=FrameOffset 2;”
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3.6 Timecode
3.6.1 Start time
Start Time is a metadata value that gets saved into the encoded Dolby E
file. It can be used during decoding to, for instance, position the audio relative to playback of a video file. The Start Time can be typed into the text
box (see Figure 3-7)
.

Figure 3-7
3.6.2 Enable timecode
For some applications, users find it useful to write an invalid timecode into
the original encoded file, to be replaced at a later time by valid timecode.
When the timecode-enable button is selected, the encoder writes valid
timecode starting at the selected Start Time. When the button is not
selected, the encoder writes invalid timecode (see Figure 3-8)
.

Figure 3-8

3.7 Frame Rate
Dolby E files can be encoded at frame rates of 23.98, 24, 25, 29.97, and 30
frames per second. The frame rate is selected from a pull-down menu (see
Figure 3-9).The currently selected frame rate is indicated by a check mark
.

Figure 3-9
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3.8 Input Routing
There are times when you may want to encode audio into the Dolby E file
in a different order than they exist in your DAW tracks. The Input Routing
selectors allow you to rearrange the ordering of the input channels.
There is one Input Routing selector for each channel in the encoded Dolby
E file, for the Program Configuration that is chosen. Above each Input
Routing selector is the name of the destination channel in the Dolby E file
(see Figure 3-10). The currently selected input channel is indicated by a
check mark
.

Figure 3-10

3.9 Input Routing Preset
There are three common standards for the channel ordering of a 5.1 surround sound file. To make it easy to interface to input channel ordering
using different standards, the Input Routing Preset is provided to automatically set the Input Routing selectors (see Figure 3-11). The currently
selected preset is indicated by a check mark. The Input Routing Preset is
only available for Program Configurations that include a 5.1 Program
.

Figure 3-11
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4 Metadata
At the bottom of the main screen are a series of tabs. These include one
tab for each Program in the selected Program Configuration (see Figure 412). These are labeled “PGM 1”, “PGM 2”, etc. By clicking on a Program
tab, you can view and change the AC-3 metadata for that Program
.

Figure 4-12
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5 Settings
The Settings tab contains the settings that do not involve metadata or routing (see Figure 5-13). The available settings on the Settings tab may vary,
depending on which platform you are running the plug-in on
.

Figure 5-13

5.1 WAV file format
SurCode for Dolby E Encoder writes the encoded output files as SMPTE
337M .wav files. The files are normally 24-bit files. You can opt for the output files to be 32-bit.
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5.2 Prepend guard band
The SMPTE 337M spec allows for a “guard band” which is a set of empty
data points at the beginning of the file to delay the start of the first frame.
Some systems require a guard band for proper operation.

5.3 Write two mono files
If this is selected, the output will be two mono files. If it is not selected, the
output will be one two-channel interleaved file.
The mono file feature is primarily meant for Pro Tools users, since the Pro
Tools region list uses mono files.

5.4 Use selection start as starting timecode value
If this is selected, SurCode will automatically read the starting time from the
waveform selection of the workstation app, and insert it into the Starting
Time of the encoder.
Note: In Nuendo, the selection start time is not copied to the Starting Time
until the encoding process is started.

5.5 Metadata serial port
SurCode can read metadata through a serial port. This allows it to receive
metadata from external sources such as the Dolby DP570.
The external metadata feature is active whenever a serial port is selected
and encoding is not it progress. It cannot accept external metadata once
encoding has started. It is inactive whenever the selection is “None”.
External metadata will alter the metadata settings in SurCode as they come
in. If external metadata stops, SurCode will retain the last valid metadata
that it received.
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6 Using the Encoder in Media Composer and
Symphony
SurCode for Dolby E Encoder is provided as an AudioSuite encoder for
faster than real-time operation in AVID Media Composer, Syphomny and
NewCutter.

6.1 SurCode for Dolby E Encoder AudioSuite
Go to the “Settings” tab next to the bin tab and double click “Audio Project”.
(See Figure 6-14)

Figure 6-14
Set the “Session Sample Rate” to 48k (See Figure 6-15) and the Bit Depth
to 24bit. (See Figure 6-16)
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Figure 6-15

Figure 6-16
Create 8 mono audio tracks in your timeline. (See Figure 6-17)
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Figure 6-17
Import 7.1 multi-mono files into your project bin. (See Figure 6-18)

Figure 6-18
Drag these newly imported tracks into the corresponding audio tracks in
the timeline. (See Figure 6-19)
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Figure 6-19
Make sure all of these tracks have the same start point and are selected on
the left-hand side of the timeline.
Go Tools-> Audio Mixer. (See Figure 6-20)

Figure 6-20
Make sure the “Sequence Mix Format” (See Figure 6-21) and the “Mix
Mode Selection” are both set to stereo. (See Figure 6-22)

SurCode for Dolby E Encoder

page 17

Using the Encoder in Media Composer and Symphony

Figure 6-21

Figure 6-22
Go File->export – Note that this step is necessary. AudioSuite can only
perform processing on multichannel audio if the audio is interleaved. (See
Figure 6-23)

Figure 6-23
Select “options” in the export window. (See Figure 6-24
SurCode for Dolby E Encoder
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Figure 6-24
Make sure to export this as “Audio”, “Direct Out”, 24bit/48kHz, WAVE. (See
Figure 6-25)

Figure 6-25
Hit Save: name the track and send it to a directory of your choosing. (See
Figure 6-26)
SurCode for Dolby E Encoder
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Figure 6-26
Import the interleaved 7.1 file you just created back into your Project bin.
Right click this file and navigate to “modify”. (See Figure 6-27)

Figure 6-27
From the top dropdown menu of the “modify” widow, navigate to “set multichannel audio”. (See Figure 6-28)
SurCode for Dolby E Encoder
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Figure 6-28
Click and hold the tab beneath A1 A2, select the program config you wish
to achieve. (See Figure 6-29)

Figure 6-29
Create a 7.1 audio track and drag the newly imported/modified interleaved
file into this track on the timeline. (See Figure 6-30)
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Figure 6-30
De-select all other tracks besides the interleaved 7.1.
Go Tools->AudioSuite (See Figure 6-31) and select SurCode for Dolby E
Encoder (See Figure 6-32) and activate the plug-in. (See Figure 6-33)

Figure 6-31
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Figure 6-32

Figure 6-33
Click “Browse” and select where you would like to send your encoded file
to be stored and enter a name. Click “save”. (See Figure 6-34)
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Figure 6-34
Click “Encode” at the top of the encoder user interface. When the file is finished rendering, you’ll see “Idle”. (See Figure 6-35)

Figure 6-35
Then click “cancel” as the newly encoded file has been sent to the directory
you specified via the “Browse” option.
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Import the file into Media Composer by navigating to the directory you
selected for the encode.
Right click on the encoded file you just imported and specify stereo from
the “Modify” option. (See Figure 6-27 through Figure 6-29)
Create a stereo audio track in your timeline and drag the Dolby E encoded
file on the stereo track.
You now have a Dolby E encoded audio file in your Media Composer timeline.

Figure 6-36
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7 Using the Encoder in Pro Tools
SurCode for Dolby E Encoder reads the selected audio in the Pro Tools
timeline for encoding into Dolby E files.
To begin, you will need to create a multichannel track within Pro Tools, or a
collection of mono tracks. To create an 8-channel track, for instance, go to
the Track menu and select New. A window will appear from which you can
choose an 8-channel track by selecting “7.1” on the leftmost pulldown
menu (see Figure 7-37). Then click on the Create button
.

Figure 7-37
This will create an 8-channel track on the timeline (see Figure 7-38)
.

Figure 7-38
Now, drag your multichannel audio file to the Regions list (on the right), and
then from the Regions list onto the track, and drag to the leftmost side (see
Figure 7-39). Make sure that the audio you want to encode is selected, as
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AudioSuite plug-ins, such as SurCode for Dolby E Encoder, can only process audio on selected tracks.
.

Figure 7-39
Next, select the SurCode for Dolby E Encoder from the AudioSuite menu
(see Figure 7-40)
.

Figure 7-40
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This brings up the Encoder plug-in (see Figure 7-41)
.

Figure 7-41
To create the encoded Dolby E file, select an output file name using the
Browse button, set the desired metadata parameters and Input Routing,
and click on the Encode button.
Note: In Pro Tools, there are 2 encode buttons, “Encode” and “Enc. w/
Region”. The “Encode” button is the one to use. The “Enc. w Region” button will encode, but will also create a new region which is a copy of the
input audio.
7.0.1 Pro Tools AudioSuite Handles
Pro Tools 10 has an added “Handles” feature within AudioSuite processing.
This feature is useful when applying AudioSuite–based effects such as
reverbs and delays. However, it is not useful when it comes to encoding
Dolby E.
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In the case of Dolby E, you should set the handle length to “(0.00).” This
parameter defaults to 2.00 seconds. This setting is located at the top left
side of the “Processing” tab in the Pro Tools “Preferences” window. (See
Figure 7-42

Figure 7-42
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7.1 Special Settings for Pro Tools
The settings tab has two special settings for Pro Tools (see Figure 7-43)
.

Figure 7-43
7.1.1 Use Pro Tools session frame rate
When this option is selected, SurCode will read the “Time Code Rate” in
Pro Tools, and automatically set the frame rate in the encoder.
7.1.2 Use Pro Tools “Session Start”
When this option is selected, SurCode will copy the Pro Tools Session Start
Time into SurCode’s Start Time. This will be the starting time for the timecode embedded into the encoded file. If “Use selection start as starting
timecode value” is also selected, the starting timecode of the encoded file
will be the selection start time offset by the Pro Tools Session Start Time.
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8 Using the Encoder in Nuendo
Nuendo will need to be set up differently depending on whether your input
soundfiles are multiple mono files or a single multichannel interleaved file.
For both scenarios, it is necessary to have Nuendo set up to use multichannel outputs. If you are not already set up for multichannel outputs, go
to Devices > VST Connections. This will bring up the window where you
create busses, including the Output bus (see Figure 8-44)
.

Figure 8-44
If you don’t have a multichannel bus, first remove your stereo bus, and then
click on Add Bus. Select a multichannel format (in the example, 7.1 Music
was chosen).
Now you can create a project for encoding. If you are starting with an interleaved multichannel file, start by dropping a single multichannel track on
the project. Do this by going to Project > Add Track > Audio. Then drag
your soundfile onto the track (see ).
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Drop the SurCode encoder onto the track by selecting it from the Inserts on
the left (see Figure 8-45)

Figure 8-45
Select a filename for the encoded file by clicking on the Browse button on
SurCode. After a file is selected, all you have to do is play the input soundfile in Nuendo, and SurCode will create the Dolby E encoded output file.
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If you are starting with mono input files, you will need to create a project
with one mono track for each channel (see Figure 8-46)
.

Figure 8-46
Then go to the Mixer window, and assign one mono sub-bus to the output
of each track (see Figure 8-47)
.

Figure 8-47
SurCode for Dolby E Encoder
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On this project, you will need to drop the encoder on the multichannel Master fader in order to pick up all of the mono inputs. Do this by clicking on the
“e” button on the Master fader (the fader on the right side of the mixer) (see
Figure 8-48).

Figure 8-48
This will bring up a new screen (see Figure 8-49). The Inserts column is on
the left side
.

Figure 8-49
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Click in the first box under “Inserts” and select the SurCode for Dolby E
Encoder (see Figure 8-50).

Figure 8-50
This will bring up the SurCode encoder window (see Figure 8-51)
.

Figure 8-51

SurCode for Dolby E Encoder

page 35

Using the Encoder in Nuendo
Nuendo is now ready to encode the 8 mono input files. Hit the Browse button on SurCode and select an output file name.
To perform the encode operation, simply play the input files on the timeline.
You can do a faster-than-real-time encode by using Nuendo’s Audio Mixdown window (see Figure 8-52)
.

Figure 8-52
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First, set the left- and right-locators on the track screen (see Figure 8-53),
and then go to File > Export > Audio Mixdown.

Locators

Figure 8-53
The mixdown will create an audio file that you will not want, so you can give
it any filename, and delete it later. The filename that you enter in the Mixdown dialog will be the name of this unwanted file and not the name of the
encoded file. For faster-than-real-time encoding, leave the “Real-Time
Export” checkbox unchecked.
The time location of the left locator is the time that is used for the Start
Time, if the “Use selection start as starting timecode value” button is
selected on the Settings tab.

Note: Please read an important Nuendo-specific note in the Addendum at
the end of this User Manual.
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9 Using the Encoder in Final Cut Pro
This plug-in is designed as an "export" command in Final Cut Pro for quick
Dolby E encoding based on sequence decisions.
To use SurCode for Dolby E Encoder, simply launch Final Cut Pro and:
1. Load a current project with a sequence containing audio tracks that you
want to encode to Dolby E.
2. Click File - Export - SurCode for Dolby Encoder. This will bring up the plugin user interface (see Figure 9-54).
3. After naming the file and entering your metadata, click on "Ok" to encode
.

Figure 9-54
Exporting Audio with timecode and frame rates from Final Cut Pro is possible in 3 different ways.
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9.1 Using sequence start time
9.1.1 Using sequence "Mark In" and "Mark Out" points
9.1.1.1 Manually

These methods are "modeless", meaning they will work depending on the
choices you make directly in the Final Cut Pro project sequence.
9.1.2 Timecode using the sequence start time:
The default setting in SurCode for Dolby E Encoder is to "Use selection
start as starting timecode value", which is an option in the "Settings" tab of
the user interface (see Figure 9-55). This setting takes the choices you
make in the sequence and applies this automatically to the encoder.

Figure 9-55
9.1.3 To Dolby E encode using the sequence start time:
1. Click File - Export - SurCode for Dolby Encoder and bring up the user interface. NOTE: The sequence starting timecode value and frame rate are automatically displayed in user interface on the "Main" tab.
2. After naming the file and entering your metadata, click on "Ok" to encode.
9.1.4 Timecode using sequence "Mark In" and "Mark Out" points:
The default setting in SurCode for Dolby E Encoder is to "Use selection
start as starting timecode value", which is an option in the "Settings" tab of
the user interface. This setting takes the choices you make in the
sequence and applies this automatically to the encoder.

1. With audio in the sequence, you may only want to encode just a portion of
the sequence timeline. If you select "Mark In" and "Mark Out" points, the timecode values for those points will be used - not the sequence start time. NOTE:
Mark selection, selecting clips in a sequence, etc are all ways to make edits and
or move clips around in the timeline, but this will NOT be used by the encoder.
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Only "Mark In" and "Mark Out" points are used in the encoder to determine timecode values.
2. Click File - Export - SurCode for Dolby Encoder and bring up the user interface. NOTE: The sequence "Mark In" and "Mark Out" point timecode values and
sequence frame rate are automatically displayed in user interface on the "Main"
tab.
3. After naming the file and entering your metadata, click on "Ok" to encode.
9.1.5 **Manual Timecode/ Frame Rate Entry:
It may useful to manually enter a timecode value that is different from the
current sequence. In order to do this:
1. Click File - Export - SurCode for Dolby Encoder and bring up the user interface.
2. Got to the "Settings Tab" and uncheck "Use selection start as starting timecode value".
3. Click back on the "Main" tab. NOTE: You will see that the timecode entry box
has been reset to all zeros.
4. Double click in the timecode field to manually enter a timecode value. Hit
enter when done.
5. Select the frame rate of your choice from the drop down menu selection.
6. After naming the file and entering your metadata, click on "Ok" to encode.
**It is possible to actually turn timecode OFF by clicking on the green timecode button.
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10 Using the Encoder in Pyramix
The following is a step-by-step procedure to set up Pyramix for Dolby E
encoding.
First, go to the Project menu and select New. This will bring up the New
Project Wizard (see Figure 10-56).

Figure 10-56
Accept the default setting by clicking on the Finish button.
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Next, open the Configuration Wizard by right-clicking anywhere on the
mixer surface, and select Settings > Wizard. Click the Next button to go to
the second screen. Select Surround Mix and Stereo Mix, and click the Next
button (see Figure 10-57 ).

Figure 10-57
On the next page, request 1 GPS strip, and click the Next button (see Figure 10-58), and on the following page, click the Finish button.

Figure 10-58
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At the top right of the mixer are the letters “M A C R O”. Click on the “C”
to go to the Configuration screen (see Figure 10-59)
.

Figure 10-59
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This is the Configuration screen (see Figure 10-60). This is where you set
up the mixer configuration. First, go to the bottom of the GPS strip (just
above the Input Strips Summary). One of the boxes indicates the number
of channels in the strip (in this case, “6 ch.”). Click on that button.

Figure 10-60
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This brings up a window that allows you to select the number of channels in
this strip (see Figure 10-61). Click on “8”
.

Figure 10-61
Next, you will need to assign speakers to each of these 8 mixer channels.
To do that, click on the channels one at a time from the list (see Figure 1062).

Figure 10-62
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This will bring up a menu of the possible speaker selections. Click on the
appropriate speaker for each of the 8 channels to assign them (see Figure
10-63)
.

Figure 10-63
When you are done, the channel list should look like this (see Figure 1064)
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Figure 10-64
Open the SurCode for Dolby E Encoder plug-in by clicking on the “VST”
button at the top of the mixer channel strip (see Figure 10-65). The plug-in
will then be listed in the little window under the “VST” button
.

Figure 10-65
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Switch from the Configure mode to the Mix mode. Open the Channel routing window by clicking on the small grid icon next to the knob on the Aux
Bus send (see Figure 10-66)
.

Figure 10-66
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Click the Auto button to clear the connections in the last 2 columns (see
Figure 10-67)
.

Figure 10-67
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Go to the next Aux Send and click on the grid icon to bring up the Channel
Routing for the stereo send. Click on the Auto button to set up the routing
(see Figure 10-68)
.

Figure 10-68
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This will turn on the connections in the last two columns (see Figure 10-69)
.

Figure 10-69
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Go to the Track view and right-click on the first track. It will bring up a menu
(see Figure 10-70). Click on Auto-Connect
.

Figure 10-70
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Now, you can bring up the SurCode user interface by clicking on the SurCode button on the Mixer. On SurCode, click on the Browse button to
select an output filename for the encoded Dolby E file. (see Figure 10-71)
.

Figure 10-71
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Make sure that SurCode is set to the same frame rate as the Pyramix
project (see Figure 10-72)
.

Figure 10-72
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To perform the encode, go to the Project menu and select Mix Down (see
Figure 10-73)
.

Figure 10-73

SurCode for Dolby E Encoder

page 55

Using the Encoder in Pyramix
In the Mix Down window, you can choose whether the mix down is done in
real time. If it is not in real time, it will encode faster (see Figure 10-74)

Figure 10-74
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When the encoding has completed, click on the Close button in the
encoder, to release the newly created Dolby E file (see Figure 10-75)
.

Figure 10-75
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11 Using the Encoder in Sequoia/Samplitude
SurCode for Dolby E Encoder is provided as a VST encoder for faster than
real-time operation in Magix’s Sequoia and Samplitude Please follow this
step by step procedure.
Before we begin, please make sure to turn off dithering while encoding a
Dolby E file as dither will corrupt the Dolby E stream.
Navigate to Play/Rec>Playback Options. (See Figure 11-76)

Figure 11-76
Navigate to Dithering Options under "Effects" and select "No Dithering.math.rounding of sample value at the top of the dithering options window. (See Figure 11-77
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Figure 11-77
Then click "OK".
Now import a 5.1 or 7.1 surround mix (Split to Mono) into your Sequoia
session timeline.
Create a "New Surround Bus" via Track>Insert new Tracks>New Surround
Bus. (See Figure 11-78)

Figure 11-78

SurCode for Dolby E Encoder

page 59

Using the Encoder in Sequoia/Samplitude
Setup your channel configuration via the "Project Surround Setup" that will
appear when you create a new surround bus.
You can also choose a channel configuration preset from the preset menu
at the top of the "Project Surround Setup" UI. (See Figure 11-79)

Figure 11-79
Navigate to the Sequoia Mixer via View>Mixer. (See Figure 11-80)

Figure 11-80
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At the base of each track in the mixer window, you can specify the output
paths of all of your channels. Set the ouputs of the tracks you wish to
encode to the surround bus you created in an earlier step. (See Figure 1181)

Figure 11-81
Click on the surround panner of each channel you wish to encode (located
underneath the eq section of the Sequoia Mixer to specify your panning
options) (See Figure 11-82)

Figure 11-82
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Add the SuCode for Dolby E VST Encoder to the surround bus you created
in an earlier step. (See Figure 11-83)

Figure 11-83
The SurCode for Dolby E Encoder will appear and you will be able to set all
of the parameters you wish to apply to your Dolby E Encode.
Click on "Browse" to specify file name and the directory in which you would
like to write this Dolby E encoded file. (See Figure 11-84)

Figure 11-84
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You will see the file name you specified in an earlier step in the grey area to
the right of "File Name". (See Figure 11-85)

Figure 11-85
Close the SuCode for Dolby E Encoder UI.
Bring the Sequoia edit window cursor to the beginning of your session and
hit play.
Allow your session to play until the end of your Project. (This will write a
Dolby E Encoded file into the directory you specified).
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12 Using the Encoder in Fairlight
The following is a step-by-step procedure to set up Fairlight for Dolby E
encoding.
In this particular example we will be using a 5.1 + 2 (stereo) configuration
as a base of operation. On the Fairlight please create 2 "link groups"
sequentially. One 5.1 and 1 stereo.(see Figure 12-86) Then Layback/
Record your mixes. “Tape Mode” is suggested as recording mode.

Figure 12-86
There are 2 ways now in which we can actually encode this into a Dolby E
file.
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Method one is a Real time pass. Choose the first member of 5.1 link group
on the Fairlight's timeline, and using the <Insert Config> menu in the Mixer
megamode - "add" the SurCode Dolby E Encoder VST plug-in. (see Figure
12-87)

Figure 12-87
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There are several parameters here that need to be setup for the Fairlight.
1) In the "input routing" section of the plug-in please choose "film" -L,C,R,LS,RS,LFE as this corresponds to the "surround" configuration of
the 5.1 link group.
2) As per this example, make sure that the "Program Configuration" is set
to <5.1 + 2> (see Figure 12-88)

Figure 12-88
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3) In the Time code section of the plug-in, make sure that Time code is
"enabled" and manually enter the Time code start value and frame rate.
These will not be detected automatically. (seeFigure 12-89)

Figure 12-89
4) In the <File Name> section "Browse" to the destination where you would
like to create the desired Dolby E file. This will pop up a standard Windows
browser where you can choose the destination and give the file a particular
name. (see Figure 12-90 )

Figure 12-90
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You are now ready to create this encoded file with a "real time pass". To
ensure that the encoded .wav file will have THE EXACT LENGTH of the
"real-time" play operation and clip length, please use the following method:
5) The Fairlight operator needs to use the "Record Clip" command.
The user will set up a "zero" pre-roll, and will obviously NOT "arm" the
tracks for the playback/encoding process (5.1 + 2).
Hold down the Record button in the transport section of the Xynergi (lowest
row on the console). The Pad on the controller displays the Record Menu
soft keys. <Hit> "clip … As there is no preroll and the track(s) are not
armed this will precisely play only the exact length of the clip(s) on the currently selected track(s). Therefore the encoded .Wav file will be exactly the
same length.
Method two gives you much faster than real time generation using rendering.
1) This time on the Xynergi please choose the "Wave" menu in the Editor
Megamode.
2) Choose the option "Plug-ins" using the Xynergi softkey.
3) Now using the jog wheel select the SurCode for Dolby E VST Encoder
plug-in, and hit the <Edit> key. This will "pop-up" the VST plug-in. (seeFigure 12-91)

Figure 12-91
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1) In the "input routing" section of the plug-in please choose "film" -L,C,R,LS,RS,LFE as this corresponds to the "surround" configuration of
the 5.1 link group.
2) As per this example (see Figure 12-91) ... make sure that the "Program
Configuration" is set to <5.1 + 2>
3) In the Time code section, make sure that Time code is "enabled" and
manually enter the Timecode start value and frame rate. These will not be
detected automatically. (see Figure 12-92)

Figure 12-92
4) In the <File Name> section "Browse" to the destination where you would
like to create the desired Dolby E file. This will pop up a standard Windows
browser where you can choose the destination and give the file a particular
name.(see Figure 12-93)

Figure 12-93
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13 iLok
This software product uses an iLok dongle for copy protection (see Figure
13-94). This dongle must be plugged into a USB port on the computer in
order for the software to run
.

Figure 13-94
When you purchase software that is protected by an iLok dongle, the
license is sent to you electronically and must be programmed into the key.
This requires that you have an account at iLok.com.
When you purchase the software, you will supply the vendor with your iLok
account user name. The vendor will send the license to your account, using
that name. Then, when you log onto iLok.com, you will be notified that a
new license has been sent to you and ask if you would like to download it
into a dongle. Just follow the simple instructions on the website.
At a later time, you may move the license to a different dongle, such as
when you want to put all of your iLok licenses on one dongle for convenience. The iLok website has instructions for making the move. There is a
charge for moving licenses except for the initial download of the license.
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14 Appendix A Program Configurations
Table 1:
Program
Configuration

Program Sequence

Configuration
Name

0

5.1 + 2

5.1 + 2

Program 1: L,R,C,LFE,Ls,Rs
Program 2: L,R

1

5.1 + 1 + 1

5.1 + 2x1

Program 1: L,R,C,LFE,Ls,Rs
Program 2: C
Program 3: C

2

4+4

4+4

Program 1: L,R,C,S
Program 2: L,R,C,S

3

4+2+2

4 + 2x2

Program 1: L,R,C,S
Program 2: L,R
Program 3: L,R

4

4+2+1+1

4 + 2 + 2x1

Program 1: L,R,C,S
Program 2: L,R
Program 3: C
Program 4: C

5

4+1+1+1+1

4 + 4x1

Program 1: L,R,C,S
Program 2: C
Program 3: C
Program 4: C

6

2+2+2+2

4x2

Program 1: L,R
Program 2: L,R
Program 3: L,R
Program 4: L,R

7

2+2+2+1+1

3x2 + 2x1

Program 1: L,R
Program 2: L,R
Program 3: L,R
Program 4: C
Program 5: C

8

2+2+1+1+1+1

2x2 + 4x1

Program 1: L,R
Program 2: L,R
Program 3: C
Program 4: C
Program 5: C
Program 6: C

9

2+1+1+1+1+1+1

2 + 6x1

Program 1: L,R
Program 2: C
Program 3: C
Program 4: C
Program 5: C
Program 6: C
Program 7: C
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Table 1:
Program
Configuration

Program Sequence

Configuration
Name

10

1+1+1+1+1+1+1+1

8x1

Program 1: C
Program 2: C
Program 3: C
Program 4: C
Program 5: C
Program 6: C
Program 7: C
Program 8: C

11

5.1

5.1

Program 1: L,R,C,LFE,Ls,Rs

12

4+2

4+2

Program 1: L,R,C,S
Program 2: L,R

13

4+1+1

4 + 2x1

Program 1: L,R,C,S
Program 2: L,R
Program 3: C

14

2+2+2

3x2

Program 1: L,R
Program 2: L,R
Program 3: L,R

15

2+2+1+1

2x2 + 2x1

Program 1: L,R
Program 2: L,R
Program 3: C
Program 4: C

16

2+1+1+1+1

2 + 4x1

Program 1: L,R
Program 2: C
Program 3: C
Program 4: C
Program 5: C

17

1+1+1+1+1+1

6x1

Program 1: C
Program 2: C
Program 3: C
Program 4: C
Program 5: C
Program 6: C

18

4

4

Program 1: L,R,C,S

19

2+2

2x2

Program 1: L,R
Program 2: L,R

20

2+1+1

2 + 2x1

Program 1: L,R
Program 2: C
Program 3: C

21

1+1+1+1

4x1

Program 1: C
Program 2: C
Program 3: C
Program 4: C
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Overview
SurCode for Dolby E is a 64 bit software toolset, in plug–in form, that encodes to and decodes
from the eight channel Dolby E mezzanine format. Being a certified encoder and decoder, SurCode
for Dolby E behaves in the same way as Dolby’s own DP572 Multichannel Audio hardware.
SurCode for Dolby E converts eight channels of discrete linear PCM files to the lightly data–reduced Dolby E format. Dolby E also adds essential metadata while formatting the data essence in a
manner that is compatible with a video infrastructure.
SurCode for Dolby E can accept up to 8 files in either WAV, BWF or AIFF format. It outputs a
stereo file that can be distributed by any digital stereo storage or transmission medium that does
not alter the data. Audio files encoded by SurCode for Dolby E are fully compatible with all branded Dolby E decoders, in either software or hardware.
SurCode for Dolby E also contains a decoder, which is essential for properly setting your encode
parameters and metadata.
Note: �������As with other data–reduced or data–compressed formats, Dolby E data cannot be altered during
carriage, storage or transmission. Gain changes, equalization, redithering or other DSP operations, when performed on Dolby E data, will destroy the LPCM information carried in the Dolby E
essence.
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System Requirements
For AAX 32 bit
•

Pro Tools 10.3.5 to 10.3.8

For AAX 64 bit
•

Pro Tools 11 or newer

For RTAS
•
•
•

Pro Tools 7.4 to 9
Pro Tools HD 8 or 9
Pro Tools LE 8 with Complete Production Toolkit

For 64 bit VST 2.4 surround–capable hosts
•
•

Mac OS 10.4 -10.8
Win 7

For Final Cut
•

Final Cut Pro 6 or 7

Installation
Current installers are available on request via the Update Your Software link in the Support
section of our web site. On the Update Your Software page, please select the product you wish to
update. Click Next and complete the form. An installer download link will be e–mailed to you.
1. Download your installer and unZIP the file.
2. Select which platform, Windows or Mac OS, and which plug-in format you would
like to install, VST, RTAS Final Cut Export or AAX.
For Windows, be sure to select the installer version, 32 or 64 bit, that matches your
operating system. Under “System type,” the System Control Panel displays which
version of OS you have installed. The Mac OS installer includes both 32 and 64 bit
versions.
3. Run the installer, which will install both the plug-in and the current PACE (iLok)
licensing framework. This includes the iLok License Manager application.

Licensing
This software product can use a 1st or 2nd Generation iLok dongle for copy protection. This
dongle must be plugged into a USB port on your host, and “visible” by the iLok License Manager in
order for the software to run. When you purchase software that is protected by an iLok USB Smart
Key, the license is generated electronically and must be programmed into the dongle. This requires
that you have an account at www.ilok.com.
When you purchase the software, you will have already supplied us with your iLok account’s
User ID. We will send the license, or a coupon code redeemable for your license, to your account.
When you launch iLok License Manager, it will indicate that a new license has been added to your
account. The new license will appear in bold type in your list of licenses. In the case of a coupon
code, you can Redeem Activation Code to receive your license. Please see iLok License Manager’s
built–in help for more information.

Operation
Dolby E workflows can be daunting if you have never had to work with the format. The
Page 6
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following recommendations will help your work go faster…
1. To ensure frame–accurate Dolby E encoding and decoding, be sure that your buffer
size setting does not exceed 512 samples.
2. Handles in Pro Tools
- In Pro Tools Preferences under the Processing tab, set the default handle length to
0.00 sec. The default is 2 sec in Pro Tools 10, which produces a 4 second discrepancy
that will ruin any Dolby E workflow.
- Under the same Processing tab, deselect AudioSuite Dithering, if the option is
available. As noted earlier, dithering will destroy the Dolby E data, rendering your
PCM unrecoverable.
3. Make sure that each of your Pro Tools sessions maintain a sample rate and word
length of only 48 kHz at 24 bits.
To help you get up-and-running quickly, we recommend that you review our tutorials
for integrating SurCode for Dolby E into your workflows. These are available at:
https://www.youtube.com/results?search_query=SurCode%20for%20Dolby%20
E&sm=12

Nuendo
In Nuendo, care should be taken when dragging onto the timeline newly encoded files that have
the same name as a previously placed file. Nuendo caches waveform data and other attributes of all
files in the Pool, and you cannot manually flush that cache.
The cache may cause the file duration to be displayed incorrectly. In order to avoid this confusion, simply delete the existing file from the Pool prior to dragging in the replacement file.
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